
           

Book  Page iii  Monday, December 2, 1996  2:05 PM
T A B L E  O F  C O N T E N T S

Chapter 1:  Welcome . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Before You Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
What’s in the Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
User’s Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Calibration Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Registering PaperPort . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
What You Need . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
If Your Computer Does Not Have an Available COM Port . . . . . . . 5
Getting Help  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Contacting Visioneer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Chapter 2:  Connecting Your Scanner  . . . . . . . . . . . . . . . . . . . . . . . . . 7
The PaperPort mx Scanner . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Connecting the PaperPort mx Scanner . . . . . . . . . . . . . . . . . . . . . . 10

Chapter 3:  Installing the PaperPort Software . . . . . . . . . . . . . . . . . . 13
Installing the Software for Your Computer . . . . . . . . . . . . . . . . . . . 13

If Your Computer Is Running Windows 95 or NT  . . . . . . . . 14
If Your Computer Is Running Windows 3.1 or 3.11  . . . . . . . 15

Calibrating the PaperPort mx Scanner  . . . . . . . . . . . . . . . . . . . . . . 16
Checking It Out . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Trying the One-Minute Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Installing Additional Applications  . . . . . . . . . . . . . . . . . . . . . . . . . 19
Viewing the PaperPort 3.6 Software User’s Guide  . . . . . . . . . . . . . 19

Chapter 4:  Setting Up the Scanner  . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Adjusting the Paper Return  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Testing the PaperPort Button . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Selecting Scan Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
iii



 

iv

 

T

 

ABLE

 

 

 

OF

 

 C

 

ONTENTS

         

Book  Page iv  Monday, December 2, 1996  2:05 PM
Appendix A:  Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Installation Problems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25
PaperPort Scanner Not Found . . . . . . . . . . . . . . . . . . . . . . . . . . . .26
PaperPort Scanner Will Not Scan . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Mouse or Modem Stops Responding  . . . . . . . . . . . . . . . . . . . . . . . 29
Changing the COM Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .32
Finding the Scanner . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .33
Recalibrating the PaperPort mx Scanner . . . . . . . . . . . . . . . . . . . . . 33

Appendix B:  Maintenance and Technical Information  . . . . . . . . . 35
Cleaning the PaperPort Scan Mechanism . . . . . . . . . . . . . . . . . . . . 35
PaperPort mx Scanner Specifications  . . . . . . . . . . . . . . . . . . . . . . . 36
German Noise Declaration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .36
EC Declaration of Conformity . . . . . . . . . . . . . . . . . . . . . . . . . . . .37

Appendix C:  Upgrading Your Software  . . . . . . . . . . . . . . . . . . . . . 39
Before You Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .40
If You Have a PaperPort Vx Scanner or an HP 4p, 4c, or 

4s Scanner  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .40
If You Have a PaperMax or PaperPort 2.0 Scanner  . . . . . . . . . . . . 41

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43



  

Table

of Contents

              

Book  Page 1  Monday, December 2, 1996  2:05 PM
C H A P T E R  1

Welcome

Congratulations on your purchase of the PaperPort mx scanner, a desktop 
scanner with which you can quickly scan paper documents and get 
electronic images of those documents on your computer. 

The PaperPort scanner comes with Visioneer’s award-winning software that 
you can use to annotate, organize, and find scanned items. With the 
document communication features, you can send scanned items 
electronically using links to other applications, such as electronic fax, 
electronic mail (e-mail), and word processing applications, without leaving 
PaperPort. 

Sharing items with others, even if they do not own the PaperPort scanner 
or software, is possible with PaperPort Viewer. PaperPort Viewer is 
available for Windows and for Macintosh computers. 

BEFORE YOU START

Before installing the scanner and its software on your computer, please read 
this chapter. It contains important information about the necessary 
computer requirements, how to get assistance if you need it, and other 
helpful information.

▼ NOTE: If you already own a PaperPort scanner or an HP scanner that 
runs with the PaperPort software, see Appendix C, “Upgrading Your 
Software.” 
1
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WHAT’S IN THE BOX

Before you start the installation, check the contents of the box to make sure 
that all parts are included. If any items are missing or you notice any 
damage, contact the dealer where you purchased the scanner.

HARDWARE

The PaperPort scanner hardware consists of:

▼ NOTE: Use the 9-pin to 25-pin adapter only if your computer’s serial 
(COM) port has a 25-pin connector.

PaperPort mx scanner

Power adapter PaperPort
serial cable

9-pin to 25-pin adapter 
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SOFTWARE

The box contains the PaperPort software CD (compact disc). The CD 
contains all the necessary software for setting up and using your scanner. 

▼ NOTE: If your computer does not have a CD-ROM drive, please see 
the card included with your scanner for ordering the software on disks 
from Visioneer.

USER’S GUIDE

The PaperPort 4.0 Software Getting Started Guide provides information to 
get you started using the PaperPort 4.0 Software with Windows 95. If you 
are using your scanner with Windows 3.1 or Windows 3.11, see the 
PaperPort 3.6 Software User’s Guide on the PaperPort CD. In addition, a file 
named README, located on the CD, contains information that was not 
available when the guide was printed. 

CALIBRATION PAGE

Calibrating the scanner adjusts its internal scanning mechanism to produce 
the best possible scan image. The calibration page included with your 
PaperPort mx scanner is a plain white sheet of paper cut to the appropriate 
size. You can also use a regular clean white sheet of paper.

REGISTERING PAPERPORT

After you install the PaperPort software, a registration screen appears so 
you can easily register your scanner and software. Registration entitles you 
to information about product upgrades and other services from Visioneer. 
You can register electronically or by fax, phone, or mail. Information for 
registering is also on the PaperPort CD.

User's
Guide
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WHAT YOU NEED

To use the scanner and software, you need the following:

■ IBM PC (or 100-percent compatible) 486 or higher for PaperPort 4.0; 
an IBM PC 386 or higher for PaperPort 3.6.

■ Microsoft Windows 95, Windows 3.1, or Windows for Workgroups 3.11.

■ 8 megabytes (MB) or more of internal memory (RAM), or 4 MB if you 
have your own OCR software and decide not to install the OCR 
software included with the PaperPort software.

■ 20 MB of free hard disk space if your computer is running Windows 95; 
12 MB of free hard disk space if your computer is running 
Windows 3.1.

■ An available serial port (COM1, COM2, COM3, or COM4). 
If your computer does not have an available COM port, please read the 
section below.

■ A VGA or SVGA monitor. Recommended settings for your monitor are 
256 colors or more, and 640 by 480 resolution.

■ A CD-ROM drive to install the software; however, if your computer 
does not have a CD-ROM drive, you can get disks from Visioneer. 
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IF YOUR COMPUTER DOES NOT HAVE AN AVAILABLE 
COM PORT

You have several options if your computer does not have an available COM 
port to connect the scanner:

■ Use Visioneer’s special parallel port adapter to connect the scanner to 
one of your computer’s parallel ports. A card for ordering the adapter is 
included with your scanner. This is the recommended option.

■ Install a serial I/O card into your computer. A serial I/O card adds more 
COM ports to your computer. Most computers have built-in ports for 
COM1 and COM2. When you install a serial card, the new ports are 
usually configured to be COM3 and COM4. Contact your computer 
dealer to purchase a serial I/O card.

■ Use another type of mouse on your computer. Some computers use 
COM1 for the mouse connection, but you can also purchase a mouse 
(called a Bus mouse) that does not use a COM port, thereby making 
COM1 available for connecting the scanner. If your computer uses COM1 
for the mouse, contact your computer dealer to purchase a Bus mouse.

GETTING HELP

If after installing the scanner and its software you still have questions or the 
scanner doesn’t seem to work properly, see Appendix A, “Troubleshooting.” 
It has additional answers to many common questions.

PaperPort also has a complete help system to provide assistance and answer 
questions about the scanner and its software.

To get help while running the PaperPort software:

■ Press the F1 key, or from the Help menu, choose PaperPort Help 
Topics to display the Help Topics window.
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CONTACTING VISIONEER

Visioneer provides support in a variety of ways:

■ You can have Tech Notes and other information sent directly to your fax 
machine from the Visioneer automated fax-on-demand center. You can 
also fax questions directly to the technical support staff.

■ You can reach Visioneer on America Online and the World Wide Web. 
You can download Tech Notes, post questions, or chat with other 
PaperPort users.

■ You can call the Visioneer Technical Support Hotline.

For specific information and numbers to call, see the technical support 
card that you received with your scanner.
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C H A P T E R  2

Connecting Your Scanner

This chapter describes the scanner’s features and shows how to connect it 
to your computer.

▼ NOTE: The section, “Connecting the PaperPort mx Scanner” on page 10, 
assumes you are connecting the scanner to a COM port. If you are 
connecting the scanner to a parallel port, please see the instructions that 
you received with the Visioneer parallel port adapter.
7
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THE PAPERPORT MX SCANNER

Front view

Top view

Rear view

PaperPort button

Page markers

Page feed

Paper return

Paper return settings

Pass straight through

Return to front

Power jack

Serial jack

8

7

6

5

4

3

2

1

Security connector
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1 PaperPort button. Press to cancel a scan in progress. If the paper jams, press to back the paper 
out. Press before scanning to select new scan settings.

Page markers. Insert items to scan between these two elevated tabs.

Page feed. Insert an item to scan face up into the page feed. The feed mechanism will grab the 
item and pull it the rest of the way through. The PaperPort application will automatically start.

Paper return. Rotate forward or backward to set the paper output path (straight-through or 
return-to-front). Use the straight-through setting for small items, such as business cards, or for 
thicker, heavier-weight paper.

Paper return settings. Rotate the paper return to align either setting with the arrow on the 
PaperPort body. 

Power jack. Plug the power adapter into this jack.

Serial jack. Plug the serial cable into this jack.

8

7

6

5

4

2

3

▼ NOTE: The scanner does not have an on/off switch. Simply insert the 
paper into the scanner to start it.

Security connector. Plug a MicroSaver Security System cable into this connector and secure 
the scanner to your desk. (MicroSaver is available at major computer resellers.)

THE PAPERPORT MX SCANNER, CONTINUED
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CONNECTING THE PAPERPORT MX SCANNER

The PaperPort scanner connects to any available serial (COM) port on the 
back of your computer. 

To connect the PaperPort scanner:

1. Turn off the power to your computer. (Remember to save any open 
files first.) 

2. Plug the PC end of the serial cable into any available serial (COM) 
port on the back of your computer.

If the serial port on your computer has a 25-pin connector, use the 
adapter included in the box.

If the serial port on your computer is a 9-pin connector, do not use the 
adapter. Plug the 9-pin end of the cable directly into the serial port on 
the back of your computer.

Connecting to a 
25-pin serial port

Adapter

Connecting to a 
9-pin serial port
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3. Plug the other end of the serial cable into the round port on the back 
of the scanner. 

Note that the plug fits only one way. If it does not attach easily, make 
sure that you are plugging it in correctly. Do not force the plug into 
the connection.

4. Plug the power adapter into an AC (wall) outlet. 

5. Plug the power cable into the power jack on the back of the scanner.

Listen for a short hum from the scanner. This sound indicates that the 
scanner is receiving power.

6. Place the scanner at a convenient place on your desk—for example, 
between your keyboard and monitor.

SECURING YOUR PAPERPORT SCANNER

Your PaperPort scanner has a built-in security connector to enable you to lock 
down and protect your valuable equipment. The security connector is located 
on the rear of the scanner and is identified by a small molded icon.

The MicroSaver Security System is a cable and locking device custom 
designed to work with this connector. The locking device inserts into the 
connector, and the steel cable wraps around and secures to a desk leg or 
other immovable object.

MicroSaver is available at major computer resellers. Or, call Kensington 
Microwave Limited at 1-415-572-2700 or 1-800-535-4242 (in the U.S. 
and Canada) for more information.

Serial cablePower cable
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C H A P T E R  3

Installing the PaperPort 
Software

This chapter tells you how to:

■ Use the PaperPort CD to install the software on your computer.

■ Calibrate the scanner.

■ Check that both the scanner and the software are working correctly.

■ Try the One-Minute Guide. 

■ Install additional applications.

INSTALLING THE SOFTWARE FOR YOUR COMPUTER

The PaperPort CD includes two versions of the PaperPort software. 
Please make sure that you install the correct version for your computer.

If your computer is running...
Install this version of 
the PaperPort software

Windows 95 or Windows NT PaperPort 4.0

Windows 3.1 or Windows 3.11 PaperPort 3.6
13
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To install the PaperPort software from the CD:

1. Before inserting the PaperPort CD into the CD-ROM drive, find the 
serial number printed on the CD. Write down the serial number. 
You will need it when installing the software.

2. Start Microsoft Windows and make sure that no other applications are 
running.

3. Insert the PaperPort CD into your computer’s CD-ROM drive. 

4. Please refer to the appropriate section for the steps to install the 
software on a computer running either Windows 95 or Windows 3.1 
(or 3.11).

▼ NOTE: To install on a notebook computer, you may have to turn on 
the COM port manually prior to installing the software. Please see your 
notebook computer user’s manual for details.

IF YOUR COMPUTER IS RUNNING WINDOWS 95
1. Insert the PaperPort CD into your computer’s CD-ROM drive. 

The CD will automatically start.

2. Follow the instructions on the screen to install the PaperPort 4.0 
Software on your computer.

▼ NOTE: If the PaperPort CD does not automatically start, make sure 
the CD drive’s door is completely shut. If the CD still doesn’t start, click 
the Windows 95 icon named My Computer. The window shows the 
drives connected to your computer. Double-click the icon for your CD-
ROM drive to see the list of files on the CD. Double-click the file 
named START.EXE. The CD will start.

When the software installation is complete, a message asks you to calibrate 
the scanner. Please see “Calibrating the PaperPort mx Scanner” on page 16.
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IF YOUR COMPUTER IS RUNNING WINDOWS 3.1 OR 3.11
1. From the Program Manager File menu, choose Run.

The Run dialog box appears.

2. If your CD-ROM drive is designated as drive D, type 

D:\START

in the Command Line box and click OK.

If your CD-ROM drive is another drive, type the appropriate drive 
letter (such as E:\) followed by START, and click OK.

The CD’s installation screen appears. Follow the instructions to install 
the PaperPort 3.6 Software on your computer.

After the files are copied to the hard drive, restart Windows. 
The following dialog box appears so the software can find the port 
where the scanner is connected. 
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3. Click Find Scanner. 

The setup program automatically finds the port where the PaperPort 
scanner is connected and makes any changes to the port settings that 
are necessary for the scanner to work properly. If the scanner and port 
are properly connected, the scanner makes a short humming sound.

If the scanner is not connected correctly, a message tells you that the 
scanner was “Not Found.” Make sure that each cable is connected 
correctly, and click Find Scanner again. 

4. Click OK. 

A message tells you to restart Windows to accept the new settings for 
the port.

5. Click Restart.

That completes the installation of the PaperPort 3.6 Software. You now 
need to calibrate the scanner. 

CALIBRATING THE PAPERPORT MX SCANNER

Calibrating adjusts the scanner’s internal scanning mechanism to produce 
the best possible scan image. To calibrate, use the calibration page included 
with the scanner. You can also use any plain white sheet of paper that is 
9 inches (22.9 cm) wide and at least 6 inches (15.2 cm) long.

To calibrate the scanner:

■ Insert the 9-inch edge (the wider edge) of the calibration page into the 
scanner. If you’re using a regular white sheet of paper, insert it sideways, 
not lengthwise, into the scanner.

The sheet should extend over the two page markers that you use as 
guides when inserting items. The scanner grabs the sheet and 
automatically feeds it through the scanner.

Calibration only takes a few seconds. Do not pull the paper out of the 
scanner while calibration is in progress. When the calibration is 
complete, the paper will be free so you can remove it.

That’s it! Your scanner is now ready for you to scan.
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CHECKING IT OUT

After completing the installation and calibration process, you should try 
out your PaperPort mx scanner.

You can scan many types of items, from small business cards to pages up to 
30 inches (76.2 cm) long. The PaperPort software also has special settings 
for scanning photos and fine print (like the fine print on a contract).

▼ CAUTION: The PaperPort scanner can scan various types of items. 
However, you should not scan anything that can get stuck in or damage 
the feed mechanism, including items containing paper sticky notes, 
glue, white-out, wet ink, staples, or paper clips.

To test the scanner and software:

■ Insert a test page, face up, into the page feed slot.

The scanner starts as soon as you insert the page. An image of the page 
appears as it is being scanned. 
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Table

of Contents18 CHAPTER 3: INSTALLING THE PAPERPORT SOFTWARE

Book  Page 18  Monday, December 2, 1996  2:05 PM
The scanned image appears as a thumbnail on the PaperPort Desktop. 
This sample is from PaperPort 4.0 for computers running Windows 95.

TRYING THE ONE-MINUTE GUIDE

Try the One-Minute Guide to quickly learn how to scan and how to use 
the PaperPort software. You can watch the One-Minute Guide by choosing 
One-Minute Guide from the PaperPort Help menu.

Thumbnail image
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INSTALLING ADDITIONAL APPLICATIONS

The PaperPort CD contains several applications that you can use with your 
scanner and PaperPort software. Each application has its own installation 
steps.

To install the additional applications:

1. If the CD is not in the CD-ROM drive, follow the steps on page 14 to 
start the CD.

2. Follow the instructions on the screen to install each application.

When you’re finished installing the additional applications, you can 
remove the CD from the CD-ROM drive.

▼ NOTE: One of the applications that you can install is PaperPort 
Viewer. You do not need to install PaperPort Viewer on your computer. 
It is an application to give to others to view scanned items. 
You can give a free copy to anyone else.

VIEWING THE PAPERPORT 3.6 SOFTWARE USER’S GUIDE

If your computer is running Windows 3.1 or 3.11 and you installed the 
PaperPort 3.6 Software, see the PaperPort 3.6 Software User’s Guide for 
information about using this version of Paperport. The PaperPort 3.6 
Software User’s Guide is available on the PaperPort CD. See the help system 
on the CD for information about reading and printing the PaperPort 3.6 
Software User’s Guide.
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C H A P T E R  4

Setting Up the Scanner

Your PaperPort mx scanner has several features that you can use for 
different scanning situations. This chapter explains how to set up the 
scanner to scan different types of items.

ADJUSTING THE PAPER RETURN

The paper return determines how the document feeds through the scanner. 
For example, a business card on heavier paper should be fed straight 
through so that it lies flat. Lighter-weight paper, such as newspaper 
clippings or letters, can be fed back toward you. 

The position of the paper return on the top of the scanner determines the 
paper return path.

Rotate the paper return to set the return path.

The alignment markers indicate the return path.
21
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To adjust the paper return:

■ To set the paper return to feed the item back toward you, align the 
U-shaped setting with the arrow.

■ To set the paper return to scan an item straight through, align the 
straight-dashed setting with the arrow.

▼ NOTE: Make sure the paper return is rotated fully so the setting 
marker aligns with the arrow. If the arrow and marker are not aligned, 
the paper will not feed through and will back out when you try to insert 
it. If the paper jams, push the button on the side of the scanner to 
manually back the paper out.
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TESTING THE PAPERPORT BUTTON

The PaperPort button is located on the left side of the scanner.

You can use the button to do three different things:

■ To back a page out of the scanner if it jams, press the button while the 
scanning is in progress.

■ To cancel the scan and back a page out of the scanner, press the button 
while the scanning is in progress.

■ To display the PaperPort Scan Settings dialog box, press the button 
before scanning. Use this technique as a shortcut to reset the scanner’s 
scan settings quickly without having to start the PaperPort software and 
open the Scan Settings dialog box.

▼ NOTE: If your version of PaperPort includes a Control Panel named 
ScanDirect, pressing the PaperPort button when ScanDirect is running 
displays the ScanDirect Preferences dialog box.

SELECTING SCAN SETTINGS

The scanner has several settings for scanning various types of items. 
For example, one scan settings is for business cards, which usually have 
smaller typefaces. The business card setting is optimized to scan small type 
to produce a sharp image of the text. Another setting is for scanning 
photographs and graphics to reproduce up to 256 shades of gray. See the 
online Help for details about the various PaperPort scan settings.
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A P P E N D I X  A

Troubleshooting

This appendix lists possible installation and operating problems that you 
may experience with your PaperPort mx scanner. The suggested solutions 
usually solve the problem. However, if you still have problems with the 
scanner, please refer to the online Help system for additional information 
and troubleshooting. 

INSTALLATION PROBLEMS

Windows fails to restart.

Please note that PaperPort does not support OS/2 or Windows 
running under OS/2 (Win-OS/2).

If Windows fails to restart when you finish installing the software, the 
installation will not run successfully and PaperPort will not work. This includes 
cases in which the system “hangs” or “freezes” or exits to DOS. Try running the 
Setup program again. If the problem occurs again, quit Windows. Then, at the 
DOS prompt, change to the Windows\System directory (usually at 
C:\WINDOWS) by typing CD\WINDOWS\SYSTEM, press Enter, type 
PPUPDATE, and press Enter. This completes the installation. Run Windows 
again, and you will see the PaperPort Port Selection dialog box.

Not enough disk space.

The PaperPort software requires at least 8 MB of available disk space when 
it is installed. If you need more space, try deleting unnecessary files or 
archiving older data to floppy disks or some other medium.
25
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PAPERPORT SCANNER NOT FOUND

Scanner not found during initial installation.

Your scanner was not found at the same port that was used during last 
Windows session.

Although you selected a port that is installed on your computer, the scanner 
cannot communicate with your computer. Be sure that the scanner is plugged 
in, that you have connected the cable to a port on the back of your computer, 
and that you have selected the correct port.

If you are sure that you selected the correct port, remove the power cord 
from the back of PaperPort and then reinsert it. You should hear a brief 
hum as the PaperPort scanner motor starts up. If you do not hear the hum, 
check for the following problems. If you encounter a problem, fix it, and 
then click the PaperPort Find Scanner button again.

■ You may have plugged the scanner power supply into a dead outlet or 
power strip.

■ The scanner power supply may not be working. 

■ The scanner may not be working.

If you hear the start-up hum, then the scanner is receiving power and has 
passed the self-test. If the PaperPort software does not find the port, check 
for the following:

■ The ribbon cable inside the computer could be loose or disconnected. 
This cable connects the port card with the DB9 or DB25 connector on 
the back of the computer. If you have experience working with your 
computer’s hardware, make sure that the cable is secure. 

■ An internal modem can be set to act as this port, thus disabling the 
external port. You may be able to correct this problem by reconfiguring 
the port (using its documentation); otherwise, contact your computer 
dealer for assistance. 
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■ An internal remote device adapter (IRDA), common in laptop 
computers, might be set to act as this COM port causing it to be 
disabled. See your laptop computer’s owner’s manual for information 
about how to disable the IRDA and re-enable the external COM port.

■ The port itself may be faulty or disabled. Refer to your computer 
owner’s manual for the steps to determine if the port is enabled. If your 
computer has another port available, try using it instead.

■ The address Windows sets for the COM port may be incorrect. To see 
the address that Windows 3.1 sets for the COM port, open the Control 
Panel, select Ports and then Settings. To see the address that Windows 
95 sets for the COM port, open the Control Panel, select System, then 
Device Manager, and Ports (COM & LPT). Note the COM port 
address, and then compare it with the hardware address. The two should 
be the same. You can find the hardware address for Windows 3.1 using 
its Microsoft System Diagnostics (MSD) program. Quit Windows, then 
type MSD at the DOS prompt. Click OK to continue, then select 
COM Ports to see the hardware addresses. MSD is not supplied with 
Windows 95. Contact your computer dealer for assistance.

The internal modem is using the same port as your scanner. 

An internal modem acts as another COM port. To avoid a conflict, 
determine which COM ports are currently installed in your computer. 
Then be sure that the new serial card is not configured to add a COM port 
that is already installed. For example:

■ If your computer has COM1 and COM4 and an internal modem on 
COM2, then configure the first port on the serial card to be COM3 and 
disable the second port. 

■ If your computer has COM1 and COM2 and an internal modem on 
COM3, then disable the first port on the serial card and configure the 
second port to be COM4.
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▼ NOTE: The scanner does not use hardware interrupts to communicate 
with the COM port, so you do not need to change IRQs when 
installing a second serial card. This prevents hardware conflicts; 
it means that you can use the scanner on COM3 or COM4 even while 
you have active devices on COM1 or COM2.

The COM port is disabled.

COM ports can be disabled. See your computer user’s manual for the steps 
to re-enable the COM ports.

Laptop computer with Infrared Remote Device Adapter (IRDA).

Most laptop computers have a single external serial COM port that must 
be disabled for the IRDA to work correctly. If this is the case, the IRDA 
must first be disabled, and then the COM port re-enabled so the scanner 
can use the external COM port. See your laptop owner’s manual for the 
steps to disable the IRDA and re-enable the external serial COM port.

PAPERPORT SCANNER WILL NOT SCAN

Before the PaperPort scanner can scan, it must communicate with your 
computer. If you have not already done so, select a COM port.

To select a COM port:

1. Start the PaperPort software.

2. Click the Settings button on the Command Bar, or from the Edit 
menu, choose Preferences. Click the Scanner button. If you’re using 
Windows 95, click the Scanner Setup tab.

3. Click the Setup button. 

4. Click Find Scanner, or alternatively select a port manually from the 
Port drop-down list.

If the scanner is not found, see “PaperPort Scanner Not Found” on 
page 26. 
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5. Make sure the checkbox for the option, Temporarily Disable 
Scanner, is not checked. 

6. Click OK. 

You will see either a “successfully connected” message or an error 
message. If you get an error message, see “PaperPort Scanner Not 
Found” on page 26 for more information. 

You can also try unplugging the power cable from the back of the scanner, 
and then plugging it back in. You should hear a brief hum when you first 
plug it in, and another hum a few seconds later if you are in Windows. 
If you do not hear a hum, see “PaperPort Scanner Not Found” on page 26 
for more information.

Current scan did not complete. Please try again.

The scanner may need to be calibrated. For more information, see 
“Recalibrating the PaperPort mx Scanner” on page 33.

The COM port may not be receiving clearly because the plug is loose. 
Check the serial cable connection. If the error message continues to appear, 
try reducing the resolution of the scan by selecting a different scan setting. 

MOUSE OR MODEM STOPS RESPONDING

In Windows 95, hardware devices can conflict, therefore you should run the 
Add New Hardware function to properly register all of the hardware 
resources on a system. This lets PaperPort become aware of all of the other 
hardware devices on the system, thus lessening the possibility of a conflict.

To run the Add New Hardware function:

1. Open the Windows 95 Control Panel. 

2. Select Add New Hardware.

3. Click the Next button on the dialog box and proceed using the default 
selections on the next dialog boxes.
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4. If new devices are located, click the Details button, not the Additions 
button.

5. If no new devices are located, click Cancel.

6. Restart Windows 95.

If you have questions about the Add New Hardware function, see the 
Windows 95 documentation.

The serial ports on some computers running Windows 95 may be affected 
when the PaperPort software is installed, causing the mouse or modem to 
stop responding. This problem occurs if Windows 95 locks the COM port 
resources, which prohibits the PaperPort software from resetting the COM 
port resources.

To overcome this problem:

1. Open the Windows 95 Control Panel. 

2. Select System and then Device Manager.

3. Select Ports (COM & LPT).

4. Select the COM port where the scanner is connected and open the 
Properties box for that port.

5. Click the box labeled Original Configuration (Current) to remove 
the checkmark. This unlocks the COM port resources. Click OK.

6. Restart Windows 95 for the new settings to take effect.

The mouse stops responding on a Windows 3.x computer.

Some older driver programs for a serial mouse can be affected by the 
PaperPort software. Contact your computer dealer for information about 
how to upgrade to a newer driver program.

Netscape Navigator Personal Edition COM Port Error.

Some versions of Netscape Navigator Personal Edition may report a COM 
port error when starting. Overcoming this problem involves two steps: 
finding the COM port where your computer’s modem is connected and 
editing the PaperPort software file named PPORTDRV.INI.
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To find the modem COM port:

1. Start the Netscape dialer application. 

2. Click Preferences and select the Modem tab. The modem’s COM 
port will be listed. Make a note of the COM port number.

3. Exit the Netscape dialer application.

To edit the PaperPort file from within Windows 3.x:

1. Start the Windows Notepad application.

2. From the File menu, choose Open and open the file named 
PPORTDRV.INI. It should be in the DATA directory in the 
PAPERPORT directory.

3. Scroll down to the Features section and find the lines:

NoDetOnCOM1=0

NoDetOnCOM2=0

NoDetOnCOM3=0

NoDetOnCOM4=0

4. Change the 0 to a 1 for the COM port which the modem uses. For 
example, if the modem is connected to COM port 2 change the lines 
to read:

NoDetOnCOM1=0

NoDetOnCOM2=1

NoDetOnCOM3=0

NoDetOnCOM4=0

5. From the File menu, choose Save, and then Exit.

6. Restart Windows for the changes to take effect.



Table

of Contents32 APPENDIX A: TROUBLESHOOTING

Book  Page 32  Monday, December 2, 1996  2:05 PM
CHANGING THE COM PORT

The PaperPort software includes a setup option for changing the COM 
port where the scanner is connected. Do not change the COM port setting 
unless you have plugged the scanner into a new port, or the COM port 
initially assigned to the scanner is defective or is not operating properly. 
Usually the only reasons to change the COM port setting are if the scanner 
is not operating properly, or you receive numerous error messages about 
communications problems, or you plug the scanner into another 
COM port.

To change the COM port:

1. If you’re running Windows 3.1, click the Settings button on the 
Command Bar, or from the Edit menu, choose Preferences, and then 
click the Scanner icon. The PaperPort Scan Settings appear.

If you’re running Windows 95, click Settings on the Command Bar, 
or from the Edit menu, choose Preferences and click the Scanner 
Setup tab. 

2. Click the Setup button. The Scanner Setup dialog box appears.

3. Click the option, Enable Scanner Auto-Search.

4. Click OK in the Scanner Setup dialog box, and then click OK in the 
PaperPort Scan Settings dialog box.

5. From the File menu, choose Exit.

6. Exit Windows and turn off your computer.

7. Unplug the scanner’s serial cable and plug it into a new COM port.

8. Restart Windows. The software will now automatically search the 
ports on your computer and find the scanner at its new COM port.

To select a new COM port manually, choose the port from the drop-down 
list, and then click the OK button. The PaperPort software finds the new 
COM port where the scanner is connected.
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FINDING THE SCANNER

If the scanner does not start when you insert a page, the computer may not 
know that the scanner is connected. You can have the software 
automatically find the scanner.

To find the scanner:

1. Click the Settings button on the Command Bar, or from the Edit 
menu, choose Preferences.

2. Click the Scanner button. If you’re using Windows 95, click the 
Scanner Setup tab.

3. Click the Setup button.

4. Click Find Scanner.

The PaperPort software searches for the scanner and displays its 
version on the dialog box.

5. Click OK.

When you click OK, you will see either a “successfully connected” message or 
an error message. If you get an error message, see “PaperPort Scanner Not 
Found” on page 26 for more information. If you get a message that the scanner 
is successfully connected, you are ready to scan.

RECALIBRATING THE PAPERPORT MX SCANNER

Calibrating the scanner fine-tunes the amounts of black and white that 
appear on the scanned image. After using the scanner for awhile, 
recalibration may be necessary if you:

■ Notice that scanned items have black-or-white lines running through 
them.

■ Receive a message telling you that the scanner needs to be calibrated.
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■ Connect the scanner to another computer where the PaperPort software 
is already installed.

■ Install and use one scanner on the computer and then connect a 
different scanner to the computer. 

To recalibrate the PaperPort scanner: 

1. Use the calibration page that you received with the scanner, or cut or 
fold a blank, white piece of paper so that it is 9 inches (22.9 cm) wide 
and at least 6 inches (15.2 cm) long.

2. Click the Settings button on the Command Bar. If you’re using 
Windows 95, click the Scanner Setup tab.

3. Click the Setup button to display the Scanner Setup dialog box. 

4. Click the Calibration button. A message asks you to insert the paper 
to begin calibrating the scanner. 

5. Insert the 9-inch (22.9 cm) edge of the paper into the center of the 
scanner’s page feed slot. Or click Cancel to skip the calibration. 
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A P P E N D I X  B

Maintenance and 
Technical Information

The PaperPort mx scanner is designed for a long life of continuous use. You 
need to clean the scanner only if images begin to lose their quality when 
scanned. This chapter tells you how to clean the scanner and lists the 
scanner specifications.

CLEANING THE PAPERPORT SCAN MECHANISM

If you scan items that have excessive amounts of dirt or dust, the scanner 
can get dirty. To clean the scan mechanism, purchase a good-quality paper-
cleaner page that is used for cleaning copy machines and fax machines. 
Paper-cleaner pages are available from most office supply stores.

Follow the instructions in the paper-cleaner kit, and insert the paper-
cleaner page into the scanner to clean its scan mechanism.
35
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PAPERPORT MX SCANNER SPECIFICATIONS 

GERMAN NOISE DECLARATION

The German Noise Declaration is required in Germany. It gives noise 
output figures for the scanner. 

Geräuschemission
LpA < 70 dB

am Arbeitsplatz
normaler Betrieb
nach DIN 45635 T. 19
Die Daten sind die Ergebnisse von Typprüfungen.

Scanning resolution Optical resolution: 
Horizontal 200 dpi
Vertical 400 dpi

Item sizes
Maximum 8-1/2 x 30 inches (21.6 x 76.2 cm)
Minimum 2 x 3 inches (5.1 x 7.6 cm)
Scanner dimensions
Height 3-1/2 inches (8.9 cm)
Width 3 inches (7.6 cm)
Length 12-1/2 inches (31.7 cm)
Weight 2-1/2 lb (1.13 kg)
Operating temperature 50°–140° F (10°–40° C)
Relative humidity 20%–80%
Power supply
Input voltage/frequency 100 V AC, 50/60 Hz, 110–127 V 

AC, 60Hz, 220–240 V AC, 50/60 Hz
Output voltage/current 24 V DC, 750 mA
Safety and agency certifications FCC Class B, CE
Hardware warranty One-year limited warranty
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EC DECLARATION OF CONFORMITY

We, Visioneer Inc., declare under our sole responsibility that the product:

VISIONEER PAPERPORT mx SCANNER

by:
Visioneer
Hollybush House
68 Liberty Hall Road
Addlestone Surrey KT15 1SS 
United Kingdom

to which this declaration relates, is in conformity with the requirements of the 
following EC Directives:

• Council Directive 73/23/EEC on the harmonization of the laws of the Member 
States relating to electrical equipment designed for use within certain voltage 
limits.

• Council Directive 89/336/EEC on the approximation of the laws of the Member 
States relating to electromagnetic compatibility.

Conformity with Directive 73/23/EEC is based upon compliance with the 
harmonized safety standard

EN 60950 (1993).

Conformity with Directive 89/336/EEC is based upon compliance with the 
harmonized EMC standards:

EN 55022 Class B(1987)
EN 50082-1 (1992)
[IEC 801-2 1991]
[IEC 801-3 1984]
[IEC 801-4 1988]
EN 61000-3-2 (1995)
EN 61006-3-3 (1995)

Mammad Safai
Electrical Engineering Manager

Signed: Date of Issue: May 7th, 1996



Table

of Contents38 APPENDIX B: MAINTENANCE AND TECHNICAL INFORMATION

Book  Page 38  Monday, December 2, 1996  2:05 PM



Table

of Contents

Book  Page 39  Monday, December 2, 1996  2:05 PM
A P P E N D I X  C

Upgrading Your Software

If you already own an earlier version of the PaperPort software or an HP 
scanner that uses the software, you can upgrade to PaperPort 3.6 Software 
or PaperPort 4.0 Software. The upgrade software is on the PaperPort CD.

The PaperPort CD includes two new versions of the PaperPort software:

■ PaperPort 4.0 for computers running Windows 95 or Windows NT.

■ PaperPort 3.6 for computers running Windows 3.1 or Windows 3.11.

You can upgrade to one of these versions depending on the type of scanner 
you have and the version of PaperPort software it currently uses.

BEFORE YOU START

Before installing new software you should always back up the data files that 
hold your previously scanned items.

To back up your PaperPort data files:

1. Create a temporary directory on the hard drive. It will be for backing 
up your PaperPort data files.

2. Using Windows Explorer (Windows 95) or File Manager (Windows 
3.1 or 3.11), open the directory named PAPRPORT, and then open 
the DATA directory. It will contain a directory named DESKTOP. 
The DESKTOP directory contains your scanned data items.
39
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3. Copy the DESKTOP directory to the temporary directory you created 
in Step 1.

IF YOU HAVE A PAPERPORT VX SCANNER OR AN HP 4P, 
4C, OR 4S SCANNER

If your computer is running Windows 95 or Windows NT, you must install 
the PaperPort 4.0 Software. If your computer is running Windows 3.1 or 
3.11, you must install the PaperPort 3.6 Software. By using the PaperPort 
Express Setup, the setup program checks which version of Windows is 
running and automatically installs the right version of PaperPort. 

1. Follow the instructions on page 14 of this guide to start the PaperPort CD. 

2. Click the PaperPort Express Setup button. 

The setup program installs the right version of PaperPort. 

▼ NOTE: Before installing PaperPort, you should look at the README 
file. This file contains important information you may need before 
installing PaperPort. To open the README file from the CD Main 
Menu, click the Options & Documentation button. Click the button of 
the PaperPort version you want, and then click the Read Before Installing 
button. 

3. Follow the instructions to install the PaperPort software.

4. When you’re finished installing the new software, start the software and 
check that your previously scanned items are available in their folders or 
on the PaperPort Desktop. 

5. If the items are available and you created a backup directory, you can 
delete it.



Table

of ContentsIF YOU HAVE A PAPERMAX OR PAPERPORT 2.0 SCANNER 41

Book  Page 41  Monday, December 2, 1996  2:05 PM
▼ NOTE: If your previously scanned items are not available, quit 
PaperPort. Then copy all of the items in the backup directory to the 
directory named DESKTOP in the DATA directory, which is in the 
PAPRPORT directory. Start PaperPort and again check if the previously 
scanned items are available. If they aren’t, please call the Visioneer 
Technical Support Hotline.

IF YOU HAVE A PAPERMAX OR PAPERPORT 2.0 SCANNER

The PaperPort 4.0 Software does not work with a PaperMax or 
PaperPort 2.0 scanner (even if your computer is running Windows 95 
or NT). You must install the PaperPort 3.6 Software.

To install the PaperPort 3.6 Software: 

1. Insert the CD and click Continue. See page 14 for more information 
about using the CD. 

2. Click the Options & Documentation button. 

3. Click the PaperPort 3.6 button. 

4. Click the Read Before Installing button. This contains important 
information you may need before installing PaperPort. 

5. When you finish, close the window, and then click the Install 
PaperPort 3.6 button. Follow the instructions on the screen.
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6. Start your new PaperPort 3.6 Software.

The first time you run the new software, it automatically converts all 
of your previous data files to their new 3.6 format. This may take a few 
minutes, depending on the number of items you have in the 
DESKTOP directory.

When the conversion is complete and all of the previously scanned 
items are available in their folders or on the PaperPort Desktop, you can 
delete the temporary directory you created to back up your data files. 

▼ NOTE: If your previously scanned items are not available, quit 
PaperPort. Then copy all of the backup copies to the directory named 
DESKTOP in the DATA directory, which is in the PAPRPORT 
directory. Start PaperPort and, after the conversion is complete check 
again if the previously scanned items are available. If they aren’t, please 
call the Visioneer Technical Support Hotline.



Table

of Contents

Book  Page 43  Monday, December 2, 1996  2:05 PM
I N D E X
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